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1. Introduction  

Our aim in this short session is to provide you with information – and some practical skills – in the 

elements of work that are associated with using secondary survey datasets as a research resource. To use this 

workbook, read through it and follow the activity instructions when you come to them (marked ‘[A...]’). If 

anything isn’t clear or isn’t working as expected, ask one of the instructors and they will try to help.  

 

Background: Those social scientists who use secondary survey data resources for their research are aware that 

they can provide high quality, contemporary, large-scale data, for very little capital outlay. These elements ought to appeal 

equally to researchers working in or studying the third sector. Nevertheless our experience in general is that plenty of 

people don’t make as much use of secondary survey data as they reasonably might. Indeed, this view is shared by major 

resource providers and methodological institutes, who often try to promote greater uptake of secondary survey data (e.g. 

ESRC 2015; MacInnes 2009). It seems very likely that the under-use of these resources arises in part from anxiety and in part 

from gaps in skillsets and research facilities amongst potential users. The anxiety may be there because secondary survey 

data and the methods used to summarise them can easily seem to be intimidating and complex. The issues of capacity 

reflect that analysing secondary survey data usually requires specialist statistical software and benefits from confidence in a 

range of elements of statistical analysis and data management that are not widely held. These inhibitors can be overcome, 

and it is the purpose of this session to show routes toward the effective exploitation of secondary data that should neither 

be frightening, nor intangible.   

 

 

…[an image of working with a complex secondary survey dataset]:  Though it can seem frightening, the component tasks 

involved are usually a bit easier – and a bit more flexible and interesting – than many people realise… 

 

 

[A1.1]: Log in to your machine using the accreditation details provided.  

[A1.2]: Repeat to yourself – I will not be frightened by secondary survey data resources  
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2. Electronic access to secondary survey data 

Background: The practical business of working with secondary survey data is about using computing facilities to 

access then analyse existing databases. Concordantly, many of the problems that people experience when trying to 

undertake secondary survey analysis are issues in using computers effectively (rather than statistical and methodological 

challenges). Below we mention a couple of important themes, with supplementary illustrative activities.  

 

 (i) Supporting resources 

There are tonnes of resources that give advice, instructions, and replicable examples on aspects of 

using computers to undertake the analysis of secondary survey datasets. Many resources are freely available 

online; some are freely available to registered users with not-for-profit affiliations; some come with a cost. 

Though most supporting documents are electronic, there are also some very handy textbooks with relevant 

coverage – see e.g. Longhi and Nandi (2015); Treiman (2009); Elliott and Marsh (2008).  

 

 

[A2.1]: Take a quick look at the following selected open-access resources, each of which might 

potentially be useful to you sometime in the future (links also on the pdf copy of this file) 

http://www.ats.ucla.edu/stat/  One of the most popular online guides for using statistical software. 
Many survey researchers go to this site for help on software code and 
related statistical methodologies 

http://www.statsoft.com/Textbook  One of a number of sites where useful guides to statistical methods and 
techniques can be found 

http://www.spsstools.net/en/spss-tutorials/  A popular open-access resource for SPSS users 

http://www.restore.ac.uk/PEAS/about.php  

  http://www.esds.ac.uk/support/statguides.asp  

  http://www.restore.ac.uk/Longitudinal/  

Selected examples of academic training resources with various materials 
on survey data and statistical methodology. There are many other 
comparable materials available by searching online.  

http://www.ons.gov.uk/ons/guide-method/   Methodological advice on measuring and harmonising variables in UK 
social research 

https://www.ipums.org/ 

  http://www.europeansocialsurvey.org/  

Two high-quality sources of secondary data freely available to not-for-
profit users (census datasets from different countries; social and opinion 
surveys from European countries) 

http://www.scotlandscensus.gov.uk/census-results  Source for accessing macrodata (and some examples of microdata) from 
the 2011 census for Scotland.  

 

[A2.2]: Briefly visit the sites below, examples of high quality online materials which are conditional 

upon registering/approval/payment (links also on the pdf copy of this file) 

https://www.ukdataservice.ac.uk/   

(follow some links such as to ‘topic guides’, 
‘methods guides’, etc) 

UK Data Service is the main hub for secondary survey data provision and for 
supporting resources in using those surveys (access to microdata, 
documentation, analysis guides, macrodata access). Use of many UKDS 
resources requires registration, and UK and non-for-profit status.  

http://www.lisdatacenter.org/  Access to online analysis of Labour Force Surveys from across countries, 
conditional on registration.  

http://www.bristol.ac.uk/cmm/learning/online-
course/  

An example of a high quality online training resource developed for HE users. 
It concerns methods of analysis that are typically applied to surveys. Not-for-
profit use is free after registration.  

http://www.essex.ac.uk/summerschool/  

http://www.lynda.com/  

An example of high quality but commercial in-person and online training 
resources with coverage of statistical analysis and software 

http://www.stata.com/order/ 

http://www.stata.com/bookstore/  

Routes to access Stata and its textbooks – a commercial product that is 
currently popular amongst secondary survey researchers 

 

http://www.ats.ucla.edu/stat/
http://www.statsoft.com/Textbook
http://www.spsstools.net/en/spss-tutorials/
http://www.restore.ac.uk/PEAS/about.php
http://www.esds.ac.uk/support/statguides.asp
http://www.restore.ac.uk/Longitudinal/
http://www.ons.gov.uk/ons/guide-method/
https://www.ipums.org/
http://www.europeansocialsurvey.org/
http://www.scotlandscensus.gov.uk/census-results
https://www.ukdataservice.ac.uk/
http://www.lisdatacenter.org/
http://www.bristol.ac.uk/cmm/learning/online-course/
http://www.bristol.ac.uk/cmm/learning/online-course/
http://www.essex.ac.uk/summerschool/
http://www.lynda.com/
http://www.stata.com/order/
http://www.stata.com/bookstore/


4 
www.thinkdata.org.uk                                            S-CSDP, Training workshop 1 (25 Feb 2016, Univ. Stirling) 

 (ii) Understanding filestore and software 

Background: Sometimes one of the hardest parts of getting started with secondary survey data analysis is sorting 

out the various files and software that are usually used. Below we give a brief summary of the most common situations that 

apply when you are analysing data that is located on your own system (a couple of other situations, such as when using 

online data analysis tools, are described in section 6 below).   

 Most researchers using secondary survey data will use a software package that calls upon ‘command files’ to run 

processes upon the data in order to generate results and outputs. This image tries to illustrate:  

         

 

[Data file in filestore] 

             +                            

         

 

 

    [Output tables] 

                +  

[Command file] 

                          

    [Output graphs]  

                +  

     [Updated data] 

 

There are several file locations involved in this model. If you are analysing data on your own computer, you 

usually need to allocate a filestore location for your copy of the original data (and any linked documentation or metadata 

files). You typically specify another, separate, location for derived data (e.g. updated data after processing) and generated 

outputs (e.g. graphs and tables). Separately again, you would also ideally have another location which holds your 

‘command files’ and/or ‘log files’ that will record the processes that you apply to your data.  

 

[A2.3]: There are some illustrative materials at http://www.staff.stir.ac.uk/paul.lambert/IDRM2015/ . They 

cover sample data files and illustrative command files in the languages of selected software packages (they are 

used in Lambert 2015 and Lambert et al. 2015, which provide some further commentary). Try to download the 

files for chapter 5, and save them in a directory structure as indicated below.  

Put these files in a new folder called 

‘H:\csdp\data\’ 

anon_survey_data_orig.dta ; anon_survey_data_orig.sav ; 

gb91soc90.dta  

Put these files in a new folder called 

‘H:\csdp\command_files\’ 

IDRM_c5.t1.do ; IDRM_c5.t1.sps ; IDRM_c5.t1.R ;  

Make new folders called ‘H:\temp’ and 

‘h:\csdp\outputs’ 

{These will be places to store outputs for saving, and also for 

temporary storage of materials during the working process 

that do not need to be maintained} 

 

The end result should look something like:  

 

If this doesn’t work smoothly, it’s nothing to worry about. We are just trying to illustrate the typical ways that data and 

software files are organised in a carefully planned project.  

 

http://www.staff.stir.ac.uk/paul.lambert/IDRM2015/
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 (iii) Using statistical software and using ‘syntax’  

Background: With secondary survey data analysis, you nearly always need to use a specialist statistical analysis 
software package (although see section 6 below for exceptions). Additionally, you will be much better off if you use the 
software through its ‘command file’ or ‘syntax’ mode of operation.   

There are many statistical software packages that are convenient for working with secondary survey datasets. 
Most Universities have access to three packages, SPSS, Stata and R, and we illustrate these three today. In our view, the 
best of the three packages is Stata, but SPSS is a sound alternative if your organisation has access to it and not to Stata. 
However, both SPSS and Stata need to be purchased at the cost of a licence, whilst R is a freeware.  

Most people who work with secondary surveys agree that it is very desirable to use ‘syntax’ to run jobs on 
datasets, since this provides a reliable, explicit record of what you are doing. If you’re not used to it, it is hard at first to get 
used to applying tasks to datasets through the ‘syntax’ of statistical software. Using ‘syntax’ or a ‘command file’ means 
writing out commands in a language that the software uses, to then apply them to nominated datasets.  We illustrate that 
today as well, but don’t worry if it seems rather hard.  

 

 

 

[A2.4]: Via the start menu and/or desktop, find and run the links to open up SPSS, Stata and 

RStudio. SPSS is probably at ‘IBM SPSS Statistics’ on the start menu; Stata is probably under ‘networked 

applications’, and RStudio, which is a version of R, is probably under ‘networked applications’. We’ll instruct 

you differently on the day if necessary.  

 

 

[A2.5]: Choose a package (preferably Stata!) and open the corresponding ‘IDRM’ command file in it 

In Stata…. ‘Window’ -> ‘Do file editor’ -> ‘New do file’ 

‘File’ -> ‘Open’ -> ‘File’ -> Locate: h:\command_files\IDRM_c5_t1.do 

In SPSS…. ‘File’ -> ‘Open’ -> ‘Syntax’ -> Locate: h:\command_files\IDRM_c5_t1.sps 

In RStudio…  ‘File’ -> ‘Open’ -> ‘Script’ -> Locate: h:\command_files\IDRM_c5_t1.R 

 

Here is what your session might look a bit like if you’re using Stata:  

 

 

 

At present, we’re primed and ready to begin some data analysis, but we’ll pause for a moment and look at 

some other features of using electronic files, and accessing secondary survey data, before returning to using 

software in sections 4 and 5 below.  
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 (iv) Hurdles of electronic access to secondary survey data 

 

 

 

 

As we understand the situation of people who work at TSO’s, there are two main possibilities for taking 

advantage of rich and high quality secondary survey data resources:  

> Within your organisation:  

  Accessing data, data documentation files, and advice on methods of analysis ought to be easy!  

 Many of the data resources and support resources are available for use for not-for-profit research purposes to 

any individual regardless of their organisational affiliation. This includes, for example, the vast range of support 

resources and downloadable secondary survey datasets available from the UK Data Service, with which TSO 

members can register and take advantage of. Many data suppliers have conditions of access that you must 

adhere to, including secure storage of downloaded data, and an undertaking to inform the data providers about 

uses of the data; generally though these conditions are not inhibiting.  

  Saving data ought to be easy!  

 Generally you can save data files to any secure local computer. The only thing is that it is important to be clear 

where you save them, e.g. to a specified folder rather than your desktop.  

  Accessing and using software might not be easy!  

 If you want to use a high quality proprietary package such as Stata, you will have to buy one or more copies of 

the software, which may come at moderate expense. Most software is available at different costs depending on 

the category of user, so there may be some options worth exploring conditional on your situation.  

 On the face of it, the freeware R is a good alternative, but it is a pretty challenging software to work with by 

comparison to packages like SPSS or Stata. The software Microsoft Excel, which many people already have copies 

of, can in principle be used for the analysis of survey data, but the scale and complexity of most secondary survey 

datasets usually means this would be a very difficult way to work with the data.  

 

> Through an academic collaboration:  

Academic researchers generally enjoy software 

and infrastructural resources in abundance. TSO 

members can benefit from considering 

 Is there a feasible collaboration with an 

academic researcher or research student who 

might want to be involved in this research? 

 Is there a mechanism whereby you could 

become matriculated or affiliated with an 

academic research organisation meaning that 

you would be entitled to use their research 

infrastructure for relevant not-for-profit work? 

Check out the scheme on the right… 

 

 

The above may be all very well, but what if you work for an organisation that 

doesn’t have SPSS or Stata, network filestore, or libraries of books and other 

resources on how to do analysis? 
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3. Identifying and downloading secondary survey data  

 

Background: It often isn’t straightforward to identify suitable secondary survey data. First, there is the challenge 

of finding out about a resource. Second, there is the task of evaluating whether it really will provide what you want from it. 

However, once you’ve found a suitable secondary survey, it is usually quite easy to download it.  

 

 Identification: There probably isn’t one single best way to identify a good secondary survey dataset to 

use as a research resource on a particular topic. There is an online search tool provided by the UK 

Data Service (https://www.ukdataservice.ac.uk/), however it doesn’t always work as smoothly as you 

might think. Other common ways of finding plausible survey datasets include checking the sources 

and footnotes of published research to identify which surveys they used; searching with general 

purpose search engines; and just talking to the sorts of people who know about these things... 

 Evaluation: When it comes to answering specific research questions, perhaps as many as three 

quarters of secondary surveys that seem like they would be suitable, do not in fact match up to the 

task on closer inspection. Common problems include lack of questions on key topics of interest; lack 

of detail on key variables of interest; and low numbers of cases representing the sub-population that 

you are most interested in. There is no simple solution. Sometimes it is not until you have 

downloaded the survey that you can really evaluate whether it will serve your purpose. However for 

most secondary surveys accessed online, online documentation gives a good sense of the question 

format and cases (e.g. check the excellent BHPS documentation for its coverage on one topic category: 

https://www.iser.essex.ac.uk/bhps/documentation/volb/indexes/subjcat16.html#Leisure Activity).  

 

 

 

[A3.1]: Try to fill in the table below, searching online, and evaluating by looking at online documentation 

and descriptions of the survey (as per the comments above). Try to come up with a simple research question, 

then try to identify two plausible candidate datasets; clarify from where or in what situation you might be able 

to access the microdata yourself; and finally try to comment on whether, upon further inspection, the survey 

seems likely to provide you with what you’re looking for.  

A research question that I’m 
interested in answering is… 
 
………………………………………………… 
………………………………………………… 
………………………………………………… 
………………………………………………… 
………………………………………………… 
………………………………………………… 
………………………………………………… 

Two different social surveys that might have data to address that question 
are….:  

 
Survey 1: 
                      ……………………………………………………………………………………………………… 

..which I could access by:  
                       …………………………………………………………………………………………………… 
                       …………………………………………………………………………………………………… 

Survey 2:  
                       …………………………………………………………………………………………………… 

..which I could access by:  
                       …………………………………………………………………………………………………… 
                       …………………………………………………………………………………………………… 
..and on first evaluations, the best one will be…:  
                       …………………………………………………………………………………………………… 
                       …………………………………………………………………………………………………… 
                       …………………………………………………………………………………………………… 
                       …………………………………………………………………………………………………… 

 

https://www.ukdataservice.ac.uk/
https://www.iser.essex.ac.uk/bhps/documentation/volb/indexes/subjcat16.html#Leisure Activity
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[A3.2]: Download a secondary survey dataset, the European Social Survey, which is available online 

from its project website after unconditional registration. As is typical of a secondary dataset, the record is 

originally downloaded as a zip archive. Try to check off the following as you do them:  

 

1. Go to the website www.europeansocialsurvey.org and click to ‘download data’  
2. Presuming you haven’t registered before, click on ‘new user’ and fill in details including giving your own email   
3. Access your email and reply to the auto-generated information link to confirm your account  
4. Go to ‘integrated file, round 1’ and ‘download’ and choose either the SPSS or Stata version to download    
5. Save the zip file to a location on your local filestore (‘H:\csdp\data\’ should be ok)  
6. Find the zip file (e.g. using ‘Windows explorer’ and going to the folder) and extract from the zip file the underlying 

dataset and documentation (for the round 1 data, this is a file called ESS1e06_4.dta or ESS1e06_4.sav). To extract 
the file, it is usually enough to single click on the data file, click ‘copy’, and paste it into the folder. The image 
below shows what you should be able to see when this is done.  

 

 
 

7. Go back to the website, and briefly examine the documentation for the wave 1 integrated file. There are several 
files but the main documentation file is at: 
http://www.europeansocialsurvey.org/docs/round1/fieldwork/source/ESS1_source_main_questionnaire.pdf .  

 

 

 

 

 

 

 

[A3.3]: Open the downloaded ESS micro-data file in a suitable software environment. This is another 

activity that is not critical to do if it’s not making sense.  But, if you can, open up the data file and find out how 

many respondents are in the data from the different countries, by copying and applying the following code in 

your favourite software package:  

If you’re using SPSS, this ought to work:  
   get file="H:\csdp\data\ESS1e06_4.sav". 

   fre var=cntry.  
If you’re using Stata, this should be ok:  
   use "H:\csdp\data\ESS1e06_4.dta", clear 

   tab cntry  
If you’re using R this should do it:  
   library(foreign) 

   ess1 <- read.dta("H:/csdp/data/ESS1e06_4.dta", convert.factors=T) 

   table(ess1$cntry) 
 

Comment: If this worked, well done – if you weren’t one already, you now count as a secondary survey data analyst..!  

Comment: The ESS is big enough that both Stata and R have a moderate time delay in loading up the full microdata. In 

practice, most analysts reduce these delays by working with subsets of the full file, e.g. only opening up the selection of 

variables that they need for their analysis.  

http://www.europeansocialsurvey.org/
http://www.europeansocialsurvey.org/docs/round1/fieldwork/source/ESS1_source_main_questionnaire.pdf
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4. Analysing secondary survey data locally: Data management 

 

Background: Much of the work of secondary survey data analysis is better described as ‘data management’ rather 
than data analysis. This refers to pre-analysis tasks that are undertaken to prepare the data for statistical analysis, such as 
selecting valid cases and recoding the values of some variables. There are also some relatively more complicated tasks of 
data management, such as applying ‘sampling weights’ or linking supplementary data from other data files. Below we have 
a very brief introduction to some of these activities.  

 

 

 

[A4.1]: Using statistical software, implement the first part of the sample data management file 

from the ‘IDRM’ command files (‘IDRM_C5_t1.{do/sps/R}’, i.e. the file that you downloaded in section 2, 

and opened up in a relevant software ‘syntax’ editor). Run the code a line or two at a time, and see if you can 

observe and understand what it does; ask for help if you need it.  

 

…You need to open the syntax file in the software, then run lines in sequence. To ‘run’ things, highlight the relevant line(s) of 
code and ask the package to run the selection. If the data file is in the right place, the commands should run processes on 
your data file… 
 

 
In SPSS, highlight the command(s) and try ‘ctrl+r’ 

 
In Stata, highlight the command(s) and try ‘ctrl+d’ 

 
 

 

 

 

 

 

 

 

COMPLICATION: In all the examples, you need to edit the ‘path’ in the code near the top 

of the file in order that it corresponds to your own machine. Typically, change ‘H:\IDRM\’ 

to ‘H:\csdp\data\’, e.g.:   

global datafile2 "H:\csdp\data\anon_survey_data_orig.dta"  
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[A4.2]: If you have the energy, implement the second part of the data management components of 

the IDRM files (which illustrates matching data from two different files). This is not an easy thing to 

do at all – there aren’t that many academic researchers who are good at this sort of task.   

 

 

Some comments on data management 

 

 ‘Data management’ of locally stored microdata is something that it takes a bit of time to learn about. We’ll 

not take it very far today, but if you want follow-up resources, consider Long (2009) for Stata, Levesque 

(2015) (http://www.spsstools.net/en/spss-programming-book/) for SPSS, or Fox and Weisburg (2011) for 

R. You can access a number of example files on using Stata for data management at: 

www.dames.org.uk/workshops  

 At the introductory level, it’s useful to think of three categories of especially common data management 

activity that you might apply to the records in a micro dataset that you have downloaded. These are:  

(1) Recoding variables (e.g. merging some of the sparser categories together)  

(2) Dealing with missing data (e.g. deleting cases with non-valid values from the dataset)  

(3) Modifying the metadata about variables (e.g. changing value labels for categories) 

 As things get a bit more complicated, there are also many further data management tasks of increasing 

complexity. A common ‘advanced’ type of data management would involve ‘matching’ data files together. 

For instance if there are several different data files that have information that could be connected, then 

there are a few ways that this can be done (an example might be taking regional profile data from one 

source that links profiles to postcode districts, and linking it with microdata that has a geographical 

identifier). If you look out for the CSDP webinars, we plan to put some materials on some of these 

examples up in webinars in the coming months 

http://www.spsstools.net/en/spss-programming-book/
http://www.dames.org.uk/workshops
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5. Analysing secondary survey data locally: Statistical analysis  

Background: As often as not, the statistical analysis of a secondary survey dataset it a more straightforward 

activity when compared with the various preparatory steps involved above! It can get more complicated, but the process of 

identifying a suitable technique of analysis and implementing it in a standard manner is often not so hard to undertake.  

 

[A5.1]: Implement the second section of ‘data analysis’ commands from within the the ‘IDRM’ 

command files (‘IDRM_C5_t1.{do/sps/R}’, i.e. the middle section). 

Again, we just want you to try running the syntax and observe what you generate, e.g.  

 

 

 

 

 

0 5 10 15 20

2. female

1. male

4. Low school level or below

3. Higher School level

2. Diploma level

1. Degree

4. Low school level or below

3. Higher School level

2. Diploma level

1. Degree

mean of hrhswrk mean of hrhswrk2

 

 

 Further comments on data analysis:  

 With secondary survey datasets, there are generally plenty of cases to justify a more ‘sophisticated’ 
statistical analysis (that is, a multivariate one that explores the relationships between several variables at 
the same time). A key challenge for users of secondary survey datasets is therefore to identify, and 
successfully communicate, complicated multivariate patterns, typically using devices such as ‘statistical 
modelling’ 

 In the non-academic sector, a big issue is whether graphs and other results, that may be based on fairly 
complicated techniques, can be presented in an effective and accessible way. Does the bar chart above do 
a good job of conveying the dual relationship of social class and gender to the self-reported average hours 
of work per week spent upon housework? What about the regression table? 

 Lastly, we have put up on our website a brief illustrative analysis of social influences on volunteering, 
using the 2002 European Social Survey (see [A3.2] above), in the form of sample code in Stata and SPSS 
syntax files. You can download them and try them out today if you like, or save them for using at your 
leisure in the future.  
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6. Analysing secondary survey data remotely  

Background: Most of the above materials presume that you have taken a local copy of a dataset and are working 

with its ‘microdata’ . In a few different situations, though, you could be engaged in the ‘remote’ analysis of secondary 

survey data. The activities below briefly highlight some common options in this form of research.  

 

 

[A6.1]: Visit NESSTAR at the UK Data Archive and marvel at its usefulness.  NESSTAR is an integration 

project in which an online data analysis tool has been connected together to the data and metadata from a 

number of major secondary social surveys, both from the UK and from other national data archives. A common 

way to use it is via the integrated catalogue record at the UK Data Service. For example:  

i. Go to https://www.ukdataservice.ac.uk/ , enter ‘British Social Attitudes’ in the search space, and find and click on 

the link for SN6390 (the 2008 version of this survey).  

ii. Click on ‘access online’ to follow a link to NESSTAR  

iii. Navigate the left hand pane to find ‘variable description’, ‘politics’ and ‘What do you think Britain’s EU..’. You 

should see something like:  

 

iv. Note that you can take the use of NESSTAR further, for instance if you click on ‘tabulation’ or ‘analysis’ there are 

options for generating more results from this data (but you need to be registered with UKDS to do this). Note 

also that if you browse ‘up’ the tree on the left hand menu, you can see other surveys and explore their contents 

similarly  

 

 

[A6.2]: Follow the links below to see that NESSTAR is not alone as a tool for analysing secondary data 

without microdata:  

 In the NESSTAR example, you generate bespoke statistical results without ever downloading the 

microdata. Sometimes this provides more than enough data to answer research questions. A similar 

service is also available from several other data providers (e.g. the LIS calculator, from 

http://www.lisdatacenter.org/; the European Social Survey, at http://nesstar.ess.nsd.uib.no/webview/; and the 

census datasets at IPUMS, from https://international.ipums.org/international/sda.shtml ) .  

https://www.ukdataservice.ac.uk/
http://www.lisdatacenter.org/
http://nesstar.ess.nsd.uib.no/webview/
https://international.ipums.org/international/sda.shtml
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 There are also a slightly different category of ‘macro-data’ providers, from where it is possible to get 

high quality statistical data from results that have already been generated. Many of these providers 

have searchable indexes or other browsing tools from where you can retrieve interesting bespoke 

summary statistics. Try looking at the following examples:  

o http://stats.oecd.org/ for cross-national summary data on selected topic areas  

o UK Data Service guide to online macrodata: https://www.ukdataservice.ac.uk/get-data/key-

data/international-macro-databanks  

o http://www.scotlandscensus.gov.uk/census-results for 2011 Scottish census results in numerous 

formats 

o http://www.usp.scot/  bespoke data on areas of Scotland, mainly based on the census but also using 

other sources 

 Ultimately there is also the category of published literature with statistical results that could similarly 

be harnessed in a style of research that is sometimes also characterised as secondary analysis. We 

don’t need to give some links to illustrate how to read books and reports, but this is of course another 

means of obtaining data for subsequent reporting!  
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